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Technical Support
Appendix 1: Huntron Workstation Archive Scans Feature
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Huntron Workstation software Tutorial for Tracker 2800/2800S

It is very helpful if you have a working knowledge of Microsoft Windows prior to using
Huntron Workstation.

You are allowed to create a backup copy of the software disk. Your purchase
agreement allows for copies to be made for backup purposes only- copying for

distribution or resale is strictly prohibited.

Installation Instructions
Install the software BEFORE connecting any hardware. Uninstall any previous versions
prior to loading the current version. For more installation details follow the “Getting

Started” sheet included with your Huntron product.

Uninstall any previous versions of Workstation prior to installing the new version.
Insert the Huntron Workstation DVD. The DVD should Autorun and begin the
installation process. If your PC has Autorun disabled then open a browse window to
the DVD and select WorkstationSetup.exe. This will begin the installation process.
During the install you will be asked to install additional software for Access Probers.
Select NO as your response.

If you purchased CAD Tools then install using the supplied CD. Follow instructions
listed in the CAD Tools Tutorial.

If you are using Workstation in conjunction with a digital multimeter, follow the
instructions listed in the Workstation DMM Tutorial.

All of the Workstation tutorials are available on the Huntron web site:

www.huntron.com/sales-support/software.htm
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Huntron Workstation Main Interface

When starting Huntron Workstation for the first time, you will be prompted for an
activation code. Type in the case sensitive code exactly as it is presented on the

installation CD or CD envelope.

i@ Huntron Workstation (Developer) z:\Huntron\Boards\GPIB PC2 J.MDB =] ]
Flle Edit Wew Actions Tools Window Help

[Z Home Between Componert | Compare Friary

Tree Pane
- Test and editing

Signature — Tracker: Tracker 2800 Scanner: Tracker 28005

Signature Pane —5—» Channel A
- Signature display Resitance T
and scanning F‘,iwj;
500 x
Ch o =] ar
Tol [5 =] [ Fealime
Suiteh [Res =] I Filer 1
Hod | EiemFiange | |0.2 10 500
Status bar R —— ] | h [ 100 200He WM p

The Main Window for Huntron Workstation 4 features a multi-pane layout so many
aspects of the test creation and execution can be displayed at the same time. The
Panes are interactive to a certain degree in that changes in one Pane will affect other
Panes. The Panes can be resized, floated independently or “tabbed” to the sides of the
window. The Status Bar displays information about items currently selected in the Tree

pane and status information while processes are running.
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The Toolbar

The Toolbar just under the application menus allows for quick access to several

program functions. The function of each is broken out in the diagram below.

I

1. 2. 3. 4. 5. 6. 7. 8. 9.10. 11. 12.13.14. 15.16.17.18.
1. Create New Board database 10. Build New (Sequence, Component)
2. Open Board database 11. Repeat New (Sequence, Component)
3. Save As... 12. Scan Component or Net
4. Custom Button(s) (User created) 13. Scan Sequence
5. Add New (Sequence, Component or Range) 14. Send Prober head to Home position
6. Copy (Sequence, Component, Net or Range) 15. Previous Component or Net
7. Paste (Sequence, Component, Net or Range) 16. Next Component or Net
8. Cut (Sequence, Component, Net or Range) 17. Previous Pin
9. Delete (Seq., Comp., Net, Range or Scan) 18. Next Pin

Hardware Setup

When first starting Huntron Workstation, select Options from the Tools menu. The
Options window is used to setup default settings used when working in Huntron
Workstation. Your Tracker 2800 should be connected to a USB port and powered ON at
this time.

General Hardware | Proberl Color | Scan | Signalurel Sequencel Componentl Net | Fin | Hangel Test |

Hardware Settings

Tracker Frober ' Conection Steps
I Tracker 2800 j I None j 3 vl
Tracker Port Frober Serial Port #1 Acouracy [Microns]
[use =l COM1 | 10
Seanner Frame Grabber #1 Steps Per Second
[Tracker 28005 R T | 3000 -
21 Z
 Enasled I Ensbled ZEEpp IR e
I HRS Hourted T r|
Z Carrection Steps
1 vl
Z Accuracy [Microns)
50
DK [Temparary] | LCancel | Save [Permanent] | Diefault Tab Values Help
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For this tutorial, the Tracker 2800 will be referred to in general as “Tracker”.
Select the Hardware tab and set the type of Tracker hardware to Tracker 2800, the
Tracker Port (USB) and Scanner (if a Tracker 2800S is being used). Disregard the

Prober settings on the right side of the window.

Click the Connect button to initiate communication with the selected hardware. Once
connected, click the Save (Permanent) button to save this configuration as the
startup default. The Tracker 2800 will have “In Remote Mode” displayed on the LCD.

Using a Tracker 2800

The Tracker 2800 comes from the Factory calibrated for standalone use.

- Select Tools/Maintenance/Tracker 2800 Diagnostics from the menu.

Click the Alignment button. When the Alignment procedure finishes (about 10
minutes), run Verify Alignment. This also takes about 10 minutes to complete. The
Alignment information is stored in the Tracker 2800 and will be used by the software.
If changes are made to the cabling or attached instruments, simply run Alignment

and Verify Alignment again.

Manual Modes - Tracker and Scanner

Channel A

5 10K 20 5 10K 20

You may find it useful to manually test some of your components while adjusting the
range parameters. The two manual modes, Tracker and Scanner located in the
Signatures pane, can work together to display the signature of a component pin.
Tracker mode sets the range parameters, channel and tolerance. Signatures will be
displayed to the right while probing with hand-held probes (select the Realtime check
box). The Hold button will capture and hold the current signature allowing for quick
comparisons. ALT mode will switch automatically between channel A and channel B.
Scanner mode allows you to use a Huntron Tracker 2800S to interface to the

component pins. You can set the package type and number of pins (Common 1 and 2
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are not supported by the Tracker 2800S). The Scan button starts a hands free scan of
the component through the scanner cable interface or you manually increment the
pins with the << and >> buttons. The Hold button will capture and hold the current
signature allowing for quick comparisons. Manual modes are for real time display only
and does not allow for permanent signature storage. To store signatures you will need

to create a Board Test.

Creating a Board Test

There are a number of steps necessary to creating a board test.

Example of Board Test Information:
Board Name: Main Board (creates “main board.hwdb” file)
Revision: Rev. A (This field is optional)
Sequence: IC's
Component: U27 (component name) or A2 (NET name)
Pins: per pin settings for Scan Pin setting, channel, net name, etc...
Ranges: Per pin settings for common reference pin, tolerance, etc...
The user has total discretion as to the information input into these fields. There is no
“right” way as to what information is entered as every user’s situation will be different.
The above example is just one way the information might be entered.
Entering information into the Entry windows is very straight forward. The easiest way
to move from field to field is by pressing the TAB key. You can also use the mouse to

click into a particular field so you can enter information.

Test Building Procedures
- Create Test Database in the Tree Pane
o Add Board, Sequence, and Components before scanning

- Scan Components and Set References

Listed above is a general outline on how you would proceed when preparing to test a
board. These guidelines apply to all package types and boards. As with any type of
complex test equipment, practice makes perfect so take the time to learn and practice

these procedures.
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Creating a Board Database

T
MName W Manufacturer W
Revision l— Test Routine Number I—
System lCnrrtmller— Unit of Measure Iﬁ
Unit l— Data Source Lser

Top Name chp— Bottom Name Bottom

[~ Show Instructions

N
g

=
g
@

|

Help

[ ronpi.  LoadF2BFile... | Remove F28 File... |
I~ XLl Load XMLFile... |  Remove XMLFile |
Instructions |

To create a new Board, select New from the File menu or use the New button in the
toolbar. Input information into the "Add New Board” dialog as needed. The only field
that is required is board Name. Other fields such as Revision, System, Unit,

Manufacturer and Test Routine Number can be completed with related information if

desired.

Adding a New Sequence

Sequence Name: Slet [Top x| Type [Comporents — ~] oK
Order Number |1 I~ Auto Store ASCII I~ Stopon Failed CompiNet e
Compare Priority: [A] | I Show Instructions ¥ Z Home Between Comp/Met

Delete Scans
Auto Store Level: [Sequence _v| Side [Top =] T Auto Store Passed
Sequenceld i TpZUp [0 TopZ Down: |0 Buttons...
Instructions ld  [1 BottomZ Up: [0 Bottom Z Dawn: [0 Help
Auto Store File | Browse.

Instructions | Top | Bottom | Top mage | Bottom Image | Testers | Stimuius |
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To add a new Sequence, select the Sequence tab in the Tree pane. Select Add New
Sequence from the Edit menu or click the Add New button (+) in the toolbar.
Details:

Sequence Name Field: Enter Sequence name

Compare Priority: Selects the comparison priority between Same (serial number),
All (serial numbers; this is the recommended setting) or Merge (Merged min/max
signatures)

Instructions field: Enter any instructions or system information that you wish to
pass on to future users. Note: the ENTER key in this field will work as a carriage
return.

The Delete Scans button will delete all of the signature scans for the Sequence.

The Buttons... button will allow you to create a custom toolbar button that is attached
to the selected Sequence.

Other functions within this window can be read about by clicking the HELP button.

Component Package Types

Component Component

16 g DIP Component S IP MULTI }_g,;m; 4 | Grow s

4
(4pins)
package package  package . . .
[TTTTTTTITT . 0oooooooo
E—
1 10 T 8 stat ere T g —‘»
Front Panel Connector Front Panel Connector Group 2 g g Group 3
opny) | 5 o| enns
LD — . 246810 l 5 5 l
e s ECDBRETonEamS " g
T— »s8 13579 M S
— S Tracker with Scanner users
FRONT N eossoesy BOTH will use DIP, SIP, FRONT,
[TTTITTTTT package @ package or BOTH.
1 » 10 [eXcXCRINCNOXCRARCRC)
1 ———>10
Front Panel Connector e
20 il H————»20
Eﬁﬁu::i:;;ii::::i:i:# S T
T— %10 = T— 10

For Tracker with Scanner users, the package type determines how the Scanner pins
are counted. The available Scanner packages are DIP, SIP, Both, and Front. The

MULTI package may be used if a test created on another Huntron is moved to your
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Tracker 2800 system. The MULTI package will also be used for components created

using the CAD and/or HAF Import features.

Adding a New Component

Edit Component ‘
Component Name: ’[!]]— Connection Type: ’m Pause [ i
Order Number [ OpenCheckType  [Recheck ~| Ranges ThenFin ¥ Cancel
Package [DP +] OpenRecheckDepth: 3 | = Delete Seans
Mumber OfFins:  [14 o] ComectionSteps:  [3 =] Test r B
Type: T4HC4 Short Check: ’m Instructions ID ’7 %

Fin Spacing 100 Component |D: 1 Sequence ID: 1

Instructions I\u’aluas | Location |

Help l

To add a new Component, select the Component tab in the Tree pane. Select Add
New Component from the Edit menu or click Add New button (+) in the toolbar.
Details:

Component Name field: Enter the component name (reference designator) in this
field.

Package and Number of Pins fields: Using the mouse, click on the down arrow to
the right of the field to bring up the pull-down menu. Select the package type and
number of pins from these menus.

Type field: This information is optional but you can enter the component type in this
field.

Connection Type: Select the type of hardware used to interface to the component.
Select Probes if manual probes will be used or Scanner if a Tracker 2800S will be
used.

The Delete Scans button will delete all of the signature scans for the Component.
The Buttons... button will allow you to create a custom toolbar button that is attached
to the selected Component.

Instructions field: Enter any instructions or component information that you wish to

pass on to future users.
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Other functions within this window can be read about by clicking the HELP button.

Tree/Pin Tab

Once a component is added to the Workstation Tree, switching to the Pin tab will

display information for each pin of the selected component.

Tree - Board: Test Board

rEnts m Component Scans
MHumber | Order Mumber 2 | Met Hame | Scan Pin | Fauze | Channel | Pulse Typ
v
2 2 2 W1 Ird il A +
3 3 3 1355547 I il B +
4 4 4 ~Unused_Pins™ [v Il A, +
5 5 5 458818 [v I A +
E G E W2 e m & +
7 7 7 W2 e - B +
a ] a +30.5v [v I A +

Text in the Name field can be modified directly by clicking in the text field and typing
the new name. The Scan Pin setting enables or disables scanning of the pin. Pause
will cause the scan to pause when the selected pin is reached.

Information on the other settings in the Pin tab is available in the Workstation Help.
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Adding a New Range
When a new component is added to a Sequence the ranges used are set by the
defaults set up in the Tools/Options/Ranges tab. It is best to set up your desired

default ranges before adding Components to your Sequence.

Options Options

Geners | Hardvare | Prober | Cor | Scan | Sgnatre | Sequence | Camponert [ Net [ P ange [Teat | General | Hardware | Frober | Cobor | Scan | Signature | Sequence | Componert | Net | Pin Renge [ Test |
{General | Tracker |

General { Trocker |

Range 1

Tester Delay Valtage Resistance  Frequency Max Samples Tolerance

Enable ¥ [Tmcker <] [0 3 <k ][50 ~] Fiter @[5 [ <] I” Drain
Range 2 Range 2

Tester Delay Voltage Resistance Frequency Max Samples Tolerance
Enable ¥ [Tcker ] [0 - 3 =« =lfm [ Fie @ 5 =Ifs =lro
Range 3 Range

Tester Delay Voltage Resistance _ Frequency Max Samples Tolerance
Enable ¥ [Tacker <] [0 - 3 IE ~[[e | Fiter @[5 =Ifs =l o
Range 4 Rang

] Delay Voltage Resistance  Frequency Max Samples Tolerance
Enable [ [Tracker [tk [0 ] Fiter P[5 =1fs =] |i=

OK(Temporary) | Cancel | _Save (Permanent) | Default TabValves | Help | QK (Temporary) | Concel | Seve (Permanen | Defautt Tab Values ‘ Help |

In the Range/General tab, enable the number ranges and set the tester type as
Tracker (default). In the Ranges tab, set the Voltage, Resistance and Frequency range
parameters. These are the ranges that will be used when adding a new Component. It
does not change existing Components. On a new software installation these defaults
set three ranges - 3V, 50Kohms at 500Hz; 3V, 1Kohms at 200Hz and 3V, 50
ohms at 60Hz. In general use, these three ranges will work well but you may need to

add or modify ranges based on component type and value. As a general reference, the

table below can be used to assist you in setting ranges.

Range
10Q2-100Q

1KQ-10KQ

50KQ

100KQ

200mV

Continuity,
shorts,
caps,
resistors
and
inductors

Resistive
faults

Resistive
faults

Resistive
faults
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3V

Low
impedance
components

Latest MOS
and Surface
mount ICs
Resistive
faults

Resistive
faults

5V

Newer MOS
ICs

Newer MOS
ICs

Older MOS
ICs

Resistive
faults

Tracker 2800 Tutorial Rev. 9

10-15V

Power
supply and
Regulators

Older MOS
ICs

TTL 74,
74LS ICs
and older
MOS ICs
Resistive
faults

20V

TTL 74 ICs,
power
transistors

High
resistive
and High
power
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The Tracker signatures are shaped based on the Tracker range settings. The basic goal
is to achieve signatures that are halfway between open and short. The signatures for

the four basic types of components shown below illustrate this primary goal.

T T
AT
///" / /
[ | . | A
e Resistance / / Inductance
e (
L 1
e T
((. \"\I
! . |
| I(\ oA CapaCltance e N Semi-conductance
| /
/
ot L

| Fiter Select the Tree/Range tab to display

the ranges for the selected

Edit component pin. RIGHT click on the

Group Edit row header (far left grey area of the

g:::it row) to display a quick menu (shown
left)

Disable all »
Insert

— ( Add New Range to i
Copy ’b

G Range Number. Enabled Delay Tester RangeID: PinlD: Ext# 0K

Cuk = Jo ]| [Trcker ~| 1 | ==

8 nddnew Range NTETEY

0

racker]

—Tracker Range Help
Voltage: Frequency:  Max Samples  Tolerance Filter
| fo2 =] [ | [0 |5 - [s - ®
I Drain
" Current Pin
i —Scanner/Prober Settings
{* Common Pin Prober Common Pin ~ Commen Relay
1[0 = 1o =1
" Al Component/Nets e = 2p =2

" All Sequences

0K I LCancel |

4

To add a new Range, select the Range tab in the Tree pane. Select Add New Range
from the Edit menu or click the Add New button (+) in the toolbar. A pop-up dialog will
ask where you want the new range to be added. Select the desired radio button (All
Pins is generally the desired selection) and click OK.
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Add New Range Details:

Note: Voltage/Resistance/Frequency can be modified directly in the Range grid.
Voltage/Resistance/Frequency fields: Select the desired range settings

Max Samples/Tolerance/Delay: Select the setting to be used when scanning this
range

Common Pin: Common pin selection is not available with the Tracker 2800S.

Note: It is easier to set up the ranges used by selecting Tools/Options/Range from

the Tools menu in the menu bar and pre-configuring the default ranges.

Scanning with a Tracker 2800 or Tracker 2800S

To scan an entire Sequence, select the Sequence in the Tree/Sequence tab or enable
the Sequence checkbox in the Signature pane/Scan tab. To scan an individual
component, select the component in the Tree/Component tab.

Select the Scan tab in the Signatures pane and input a Serial Number then click the
Start button.

Connect to Component ] i

Please connect to Component U1,

Click OK button to start the scan, or click Cancel button to cancel
the scan. & sequence scan can be stopped by clicking Stop
button and resumed later by clicking the Continue button.

Instructions

Erevious Pin I

Stop | Cancel |

[Stops the scan allowina it to £

You will be prompted to connect to the component. Tracker with Scanner users should

connect to the selected component at this time. Click OK to initiate the Scan.

© Huntron, Inc 2018 Tracker 2800 Tutorial Rev. 9 14



Signature - Tracker: Tracker 30 Scanner: None
Sepnatures | Scan |chublcsheet§ Tracker | Scanoer | Preview |

Serial Number  Operator
fruspect 1 |
Time

S [054501 Est [000045
Elapsed PO0C08  Lekt [000040

ComponertNet
[22 o | Pass:[i o
r I /"
™ Sequence It f
Somrulus I Select _l If
Cancel

If you are performing Sequence scan you will be prompted to continue to the next

component until all of the components in the Sequence have been scanned.

If a Tracker with probes is being used your will prompted to connect to pin 1 of the
selected component (if performing a single component scan) or of the first component
in the Sequence (if performing a Sequence scan). Click the OK button to scan the first
pin. You will then be prompted to move to the next pin for scanning. Click OK to scan
and continue in this manner until all of the component pins are scanned. At anytime
during scanning you can click the Previous Pin button to go back and rescan the
previous pin.

Connect to Component i

Please connect the red probe to Component C1, Pin 2.

Click OK button to start the scan, or click Cancel button to cancel
the scan. & sequence scan can be stopped by clicking Stop
button and resumed later by clicking Continue button.

Instructions

Previous Pin Stop Cancel

Once all pins are scanned click the OK button to continue.

© Huntron, Inc 2018 Tracker 2800 Tutorial Rev. 9 15



When the Sequence or Component scan is complete the Scan Results window will be

displayed. Go to the Scan Results section of this tutorial for more information on

what to do after scanning.

Scan Results

Signature — Tracker: Tracker 30 Scanner: None
Signatures | Scan ]Troublesh&t] Tracker | Scanner | Preview

Serial Number Operator

g FAILED
Time

Start  |14:32:29 Est. [00:02:48
Elapsed [00:03:31 Left: [00:00:4
Component/Net

|2 of | Pass:[f

[~ Seguence
Stimulus:

Start

[~ Stop On Failure [~ Scan Continuous
™ Use Scan List

Tgoublesheé_r

Click the
Troublesheet
BUTTON to view
latest scan results!

When a scan is complete, the results PASSED, FAILED or NO REF will be displayed (the
text of the PASSED and FAILED message can be changed in the
Tools/Options/General settings). The NO REF message will be displayed on the first

scan of any test since there are no signatures stored as Reference.

Clicking the Troublesheet BUTTON will display the signature differences in the

Troublesheet tab of the Signature pane.

Note: Selecting the Troublesheet tab will display previous Troublesheet information.
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Viewing Signatures - Troublesheet

Signature — Tracker: Tracker 30 Scanner: None
Signatures | Scan  Troublesheet ITracker] Scanner I Preview]

Failed | Removed | Passed| No Ref|
123 | None

Summary

il |

Remove

Print

Copy
Update
Scale H

(@ 7 @D Ol S @ W e e imiwe

ik

2SN AN B e

Set Reference I Merge]

To view the Troublesheet, press the Troublesheet BUTTON in the Scan Results
window. This will display the signatures that compare differently from the Reference
signatures.

When a scan is executed signatures are compared against the Reference set (or sets)
if it exists. On the first scan, the signatures will be displayed in red and listed in the
No Ref tab. This occurs because the first scan has no reference to compare against.
To add the signatures in the Troublesheet as a Reference, press the Set Reference
button located in the lower left corner (do this only with known good signatures).
Signatures of the compared signatures are displayed in contrasting colors. By default,
the Reference signature is green and the failed signature is red.

To add the Troublesheet signatures to the Merge signature set, press the Merge
button (do this only with known good signatures that vary slightly from the original
Merge signature set).
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Viewing Signatures Troublesheet Report

Troublesheet Repork ' Py ] P4

Top Level

IS equence

Detail Level

=

Problem

lComponent/N et

k2

[Low 5

Solution

'leplaced C1

1

Preview |

Close |

Breen

uﬁile View Background

L"\\g Page Setup...

=10

A | K | K [100%

M & |

ECYIFEEn

27 print...
& Print
LE}] Export Document...  » || «/ PDF File
1 Send via E-Mail... » HTML File
@ Ext MHT File
RTF Fils Troublesheet Report
: 6/3/2008 1:25:27 PM
Excel File
Serial # :
Operator, CSY File
Resulis: Text File
Problent: Image File
Solution: —
Board Information
Nawme: 89006330 Revision: |Al [Crnit: [
Top Name: Top Gold Disk: !‘ 7 l
Bottom Name: |Bottom System:
Instructions:
Sequence Iuformation
Name: ITop IID: |1 lOMer Number: |1
Z Home Between Componenis: ITrue '.&Yop on Failed Compone: |Fa1se |Top Side: ITme
Comtponent Sequence: [True [Compare Prioriy: [All [Skow Iustructions: [False
Instructions: |
Total Component/Nets: |55 |Tom1 Scanned: |54
Total Passed:[54 [Total Faiked: J0 [TotatRemoved: [0

<

il

Current Page: 1

Total Pages: 1

Zoom Factor: 100%

To view and print the Troublesheet report, press the Print button in the Troublesheet

window. You can select from several options including a Sequence or Component Level

report, the level of detail and add problem and solution comments to the report. Click

Preview to view the report on-screen. The report can be printed or exported in

several different formats including HTML and PDF by selecting File/Export Document

in the Preview window.
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Viewing Signatures in the Signhatures Pane

Signatures

Signature — Tracker: Tracker 2800 Scanner: Tracker 28005

Troublesheet | Tracker | Scanner | Preview

Scan List:

| Il

—Scale

CHC 2634005

Copy | Frint |

Troublezhest |

(LB
T

R 3 100 Z00Hz

(LB

RZ 3 10K Z00Hz

(LB

A3 3 100K Z00Hz

Plm: 2

L |

A1 3 100 Z00Hz

Plm: 2

A2 3 10K S00Hz

Plm: 2

L | [ T B |

i
A3 3 100K F0Hz

Flm: 3

- PI - -
o

i
A1 3 100 Z00Hz

Flm: 3
T

i
A2 3 10K 00Hz

Flm: 3
T

A3 3 100K Z00Hz

1]

[+

hd

To view scanned signatures, select the Signatures tab in the Signature Pane. The

Scan name, date and time will be displayed on the left side of the window (Reference

signatures are marked with an asterisk) and signatures on the right. The Scale

buttons will change the number of columns displayed. Scaling the window will increase

the number of signatures displayed. The Copy button will copy the signatures to the

Windows clipboard so they can be pasted into another program (in a metafile format).

The Print button will print the signatures in one of several different user selected

formats.
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Viewing Signatures - Right Click

Signature

Signatures | Scan [Treubleshest | Tracker | Scanner | Preview |

Failed | Removed | Passed | No Ref |

Pin: 13[13]

/|

Update Component
Sync Pin/Range
Edit Range

Disable Range

Edit Pin

Edit Comp/Net

Group Edit

Fin: 13 [13]

R:2 3V 1K Ohm 200Hz

Pin: 1011

Met Edit

Sighssist
Sync CAD
Sync Image

Copy
Data
Pin Mode

Scale R:1 3V 50K Ohm 500Hz Find R:2 3V 1K Ohm 200Hz
C1G2036C405 4 B 04

Set Reference Merge

o
b
I
o

Lo

Additional options when viewing signatures can be displayed by right clicking in the
sighature area.

Update Component: Updates the Troublesheet for the selected component only
Sync Pin/Range: Selects pin and range in the Tree (see default in Tools/Options)
Edit Range: Selects the pin and range in the Tree and opens the Edit Range dialog
Edit Pin: Selects the Pin the in the Tree and opens the Edit Pin dialog

Edit Comp/Net: Selects the Component or Net the in the Tree and opens the Edit
Component or Net dialog

Group Edit: Opens Group Edit dialog for editing of component pin parameters as a
group

Net Edit: Opens Net Edit dialog for editing of Net pin parameters as a group

Real Time: Display signature in real time

SigAssist: Displays the SigAssist window showing calculated approximate values of
resistance, capacitance, breakdown voltage, etc. based on signature information
Sync CAD: Will link the selected sighature to the CAD image displayed in the
Image/CAD pane. Sync CAD will be disabled if there is no linked CAD data.

Copy: Places the signature image in the clipboard

Data: Displays the signatures numeric data

Range/Pin Mode: Displays signature with Range priority or Pin priority see (default
in Tools/Options/Signature tab)

Find: Searches the Troublesheet list for the component hame entered
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View SigAssist Information

Pin: 2 Deviation: 35 H/W Deviation: 0

Range: 3V 10K 200Hz Area: 1431 H/W Area: 0

Tolerance: 5

Serial # Scan Res. Cap. Power Fbd Rbd MaxV MaxI :]
Hardware 11/3/2005 2:38:24 PH 0.000 0.000pF  0.000nW ov ov 0.202V 200.000n&
001 11/3/2005 2:03:01 PH 0.000 0.000pF 270.000uW 1.29V ov 2.100V 126.000ui
001 11/3/2005 2:01:10 PM 0.000 0.000pF 450.000uw 1.11v ov 1.260V 246.000ui

Copy |

The SigAssist window can be viewed by right-clicking on a displayed signature and
selecting SigAssist. It appears as an additional pop-up window. The information
presented relates to the individual scans displayed in the signature. The calculated
resistance, capacitance, power, forward breakdown voltage (Fbd), reverse breakdown
voltage (Rbd), maximum voltage and maximum current are displayed. These values
are for troubleshooting purposes only and are not intended to be used as true
measurements. The accuracy of the SigAssist values depends greatly on the scanned
signature information. SigAssist values may not be calculated for signatures that do
not contain enough information for reasonable calculations to take place (i.e. opens,
shorts). The Copy button will put a copy of the window into the clipboard for use in

other programs.
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Component Scans Information

Tree - Board: Test Board

Serial Mumber | Operator | Scan Date Time & | Merged | Fieference | Pazzed
Thurzday, Februam 006 4:14:21 PM

Thursday, February 02, 2006 4:18:35 PM

Selecting the Component Scans tab in the Tree Pane will display all of the scans
performed on the selected component in a table format. The Scan information
displayed includes the serial number, operator, date/time, Merge setting (checked if
this scan is included in the Merge set), Reference setting (checked indicates it is set as
a comparison Reference), Pass status (will be checked if components passed
comparison), Removed status (will be checked if component was removed from
Troublesheet), Area number (highest of scanned pins), Deviation, Min/Max status and
other settings (see Help for more information).

Selecting a Scan in the Component Scans tab will display the selected scan in the
Signature pane in both the Signature tab and the Troublesheet tab.
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Component Scans - Right Clicking (Auxiliary menus)

Tree - Board: Test Board

L | Merged | Feference | FPazzed

Enable Sequence Reference
Disable Sequence Reference

hursday, February 02, 2008 4:18:35 PM

Delete Scan
Delete Scan All Componentsitets

Load Troubleshest

Right clicking on the Row bar (red arrow) of the Component Scans tab displays an
additional menu for performing specific tasks such as enabling/disabling References,
deleting a scan for the selected components or all components and loading a
Troublesheet. Enable Sequence Reference will mark the scan as a Reference for the
entire Sequence. Disable Sequence Scan will disable the selected Sequence as a
reference. Delete Scan will erase the selected scan for the current component
only. Delete Scan All Components/Nets will erase the selected scan for all
components or nets in the Sequence.

Load Troublesheet will display the selected scan in the Signatures/Troublesheet

pane.
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Component Scans - Right Clicking (Auxiliary menus)

Tree - Board: Power Supply 1

Sequenoes] Cempenents] Pins ] Ranges Component Scans I H
Serial Number Operator Scan Date Time Stimulus Id Merged Reference Pagead Remouad Ares Dieviation Min/
121 ‘wednesday, April 08, 2015 10:02:21 AM [} r I Set All Scans to Current Reference L |
123 \Wednesday, April 02, 2015 $:55:06 AM [} r I Delete All Scans to Current Reference 4 Component/Net
123 Wednesday, April 08, 2015 10:40:41 AM o r r Sort Descending
123 Wednesday, April 08, 2015 10:40:07 AM o r r r r 1867 23

< ol

Right clicking on the Column bar of the Component Scans pane displays an additional
menu for performing specific tasks such as sorting or globally setting parameters. The
menu will vary depending on the column selected. In the image above, the Reference
column header was right-clicked where you can select to set scans as Reference or
delete them.

This method is an easy way to delete non-reference scans that are listed in the
Tree/Component Scans pane. Select a scan that is a non-reference (the Reference
check box is unchecked) the right-click the column as shown above. Select Delete All
Scans to Current Reference/Component/Net or Sequence to delete the non-
reference scans for the individual Component/Net or for the entire Sequence.

Another more general method to delete non-reference scans is to select "Delete

Board Non-Reference Scans” from the Workstation Edit menu.
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Component Scans - Right Clicking (Auxiliary menus)

Tree - Board: P/N: S008656 Revision: B4

Serial Mumbh L Oner | Sean Date Time 1 : | Stimulus | Merged | Reference | Passed

260-01 | Set Serial Number Same Date/Time Scans f3:22 AM None r v =

suspe Sort Ascending :38:20 PM None r r r

Suspe Sort Descending :56:45 PM None ' [ r

suspect] TWednesday. October 29, 2014 3:34:30 PM None 'l [0 r
» D _ Thursday, October 30, 2014 2:32:29 PM

Right clicking on the Column bar of the Scans pane displays an additional menu for

performing specific tasks such as sorting or globally deleting items. In the image

above, the Serial Number column header was right-clicked.

Sequence/Component/Pin Editing — Right Click menus

Tree - Board: TrackerPXI

Paste
Cut

Delete Scans

Group Edit
Sync CAD

Name | Order Number : | Package | Number Of Pins | Test | Type | Replacement | Supplier | Part Numbe
[ Multi 2 [ CAPACITO
> B | jc ]
DIP 16 [ ADGE0S
| " DIP 24 I
v
—| Delete DI s
[
|| Insert ™
DIP 16 Ird
B Eepeat Muli 64 Ird
|  Build Probe 2 I
| copy DIP 16 Ird

Right clicking on the Row header bar of the Tree pane displays an additional menu for

performing specific tasks such as Add New, Insert, Delete, Repeat, Build (repeat

but with name incremented by 1), Copy, Paste, Cut, Delete Scans (for selected
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Component) and Group Edit. Right clicking works at all levels of the Tree pane
including Sequence, Component (shown above), Pins, Ranges and Scans.

It is also possible to select groups of components by holding the SHIFT or CTRL keys
while selecting components in the Tree. To copy, paste, cut or delete groups of
components, use the Copy, Paste, Cut or Delete Toolbar buttons below the main

menu.

ﬂ Huntron Workstation (Developer) z:" Huntron',Boards' Test Board.

File Edit Yiew Actions Tools  window Help
J%H +I:.>'3€x++++ &!"ﬂ* [T

| Tree - Board: Test Board

Components |[SFIRE

Hame | Order Humber 2 | Fackage | MHumber OF Ping | T

EG E MULTI 1
TF1 7 MULTI 1
TP2 8 MULTI 1
TP3 3 MULTI 1

Component Editing - Component Group Edit

Tree - Board: TrackerPXl
Sequences Components 1 Fins ] Ranges ] Component Scansl
Mame Order Mumber Package Mumber Of Pins Test Type Replacement Supplier Part Mumbe
C96 24 Multi 2 v CAPACITO
b -"‘_Iﬂ__ I
T |G Jc I
[v  ADGSDE
Edit
DIP 24 2
Delete e .
4
Insert S
DIP 16 v
Repeat Multi 71 4
Mz Probe 2 2
Copy DIF 16 v
Paste
Cut
Delete Scans
Group Edit
Sync CAD
4 |

Right clicking on the Row header bar of the Tree/Components pane allows for editing
of the Component information. Select Group Edit to open the Group Edit window for
the selected Component. This allows you to duplicate changes made to the selected

Component to other Components in the Tree.
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Note: Be sure to make your changes to the selected Component before using Group

Edit to duplicate the settings to other Components.

F ~— B
o5 Component/Net Group Edit * v E‘Elg
I DN T
Current Component/Net: [R83 Componert/Net |NI Pins I

Components/Nets: -

Name | Type | F‘insl PartNumber | Id =~

[~ Component Z Up

[~ Connection Type

[~ Correction Steps

™ Instructions

[” Open Check

[ Open Recheck Deth
[” Pause

[~ Pin Spacing

[~ Test

W Type

| Help | Process | Close |

To use the Component Group Edit, select the Components on the left that you wish to
change. You can SHIFT and CTRL keys to select groups or individual Components in
the list. Mark the setting you want to change by clicking the checkbox. The example
above shows the TYPE as the setting to change. Click Process to make the changes

to the selected Components.

Pin Editing — Right Clicking (Auxiliary menus)

Tree - Board: Test Board

Compaotent nges | Compongnt S cans

| Pirn Number 2 | Order Humber | Met Hame | Scan Fin | Urigue Fin | Chanrel | Py =~
[ 2
. 2 - "
¥
Group Edit ~ r
Mgt Edit 3 3 0 I r A +
synccap [ 4 V5 [ r A +
B ] ] D2 e r A +
B g B ~“Unuzed Fins™ [ - A, +
7 7 7 D3 v - A, +
g a g “Unuzed Ping™ [v¥ [ A, +
9 9 9 D4 v - A + oL
| | 3
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Right clicking on the Row header bar of the Tree/Pins pane allows for editing of the pin

information. Select Edit to open the Edit window for the selected pin.

Note: Some Pin settings can also be edited directly in the Pins grid by clicking the

appropriate field and modifying the setting.

Group Edit and Net Edit allow you make changes to the pin of a component and have

those modifications also change components that have the same number of pins within

the same Sequence.

32 Group Edit Component) A

Component.  |R1 P [T(0) Net |
Components:

[F i S-tiings To Change

I Channel

I Correction Steps

I Pulse

[ Relay Number

I Scan Pin

I Pause

™ Replace Ranges

Close ‘ Help

Pin Editing

Change the desired settings for the
current Pin first then select Group
Edit from the right-click menu (see
above). Components with the same
number of pins will be listed. Select
the components and pins you want to
be changed. Select the Pin Settings
check box(s) for the setting(s) you
want changed. Check the Ranges box
to match the ranges (this will cause
signatures to be deleted). Click the
Update Pins/Ranges button to
make the changes.

Pin

Il | Pin Name: ’17 Scan Pin:
Pin Number: ’17 Pause:
MNet Name: ’7

Correction Steps: ’97

Channel: A =

Pmber] Fulse ] Shorts] Features]

v

Relay Mumber:
Order Mumber:

Fin 1D

Component 1D:

Instructions 10:

Jii

Cancel
Help

Individual pin characteristics can be edited in the Pin Edit window. Pin Name, Net

name, Channel, Correction steps (for Access Probers) and Scan Pin
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(enable/disable scanning of the pin) can be controlled. Instructions related to the

selected pin can also be entered.

Range Editing — Right Clicking (Auxiliary menus)
There are very useful right-click menus available in the Range tab of the Tree pane.
You can right-click the column or row headers to display shortcuts to various

functions.

Tree - Board: GPIB PCZ Revision: J

Range Humber | Enabled | Drelay |V0|tage | Renatanan Commeoe

i - | b S amle | Toleran:
» v
Default Al 4 Component/Mets
2 v ] 3 m— 5 5
7 Sork Ascending equenci
3 v U 3 1o Sort Descending v 5 5

One of the most useful is the ability to make global changes based on a specific
setting. For example, to make a range setting such as Voltage, Resistance and
Frequency affect all pins (or Components or Sequences), make the desired change and
right-click the column header (as shown above). Select Set Current All — and choose
the level you want the change to affect i.e. all Pins, all Component/Nets or all
Sequences. The menu is similar most of the Range tab column header right-click

menus.
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Huntron Workstation Buttons Feature

Huntron Workstation has a built-in feature that allows any Windows based program to
be started by clicking a button in the Workstation toolbar. It is very easy to use and a
“Button” can be attached to any Board, Sequence or Component/Net. In this example,

a Button will be created for a Sequence but the process is the

same for the Board and Component/Net levels.

Name | Order Number

BOLTOM:  H To start, the Sequence edit window is opened by right-clicking

Add New

Delete
Insert

the row header for the desired sequence. The Edit window will be

displayed (see below).

Repeat T

Build YV — — 0
‘Sequence Name: Slet [Top =] Type [Components - OK

Copy Order Number [ I~ Auto Store ASCII I~ Stop on Failed Comp/Net o
Compare Pricrity: [A1 +] T Show Instructions V' Z Home Between CompiNet

Paste Delete Scans
futo Store Level: [Seqpance B ] T AutoStorePassed

Cut o Tzl [0 TepZDown: D [

d i BotomZUp: [0 Bottom Z Dow: [0 b |
Delete Scans I 2 2
Browse.

Instnuctions | Top | Bottom | Top image | Batiom image | Testers | Simuius |

Select the Buttons... button located on the right side of the Sequence Edit window to

open the Buttons Setup window.

Order Number |1 Button Level ISequence
Enabled v Parent ID |3
Caption I Button 1D I
Command Line I Browse... |
File Path | Browse... |
Icon File Path | Browse... I
— Tooltip
Store File in Database ————— Store lconin Database —————
I” Store File LoadFile. I ( I Store leon Load File... |
Previous | Hest | Add New I oK | LCancel I Help |
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To configure the Button, a Caption (button name displayed in the Tools menu),
Command Line (the application to be run) and File Path (the file opened by the
executed application) need to be input into the corresponding fields. A File path will
not always be required such as instances where a browser is started and pointed to a
specific URL. In this example, the button will be configured to start the Microsoft Paint
application and open a small PCB image (see image below). If desired, the icon
displayed in the main window toolbar can be set by browsing to and setting a path to
an .ICO (icon) file in the Icon File Path field. Add text that will be displayed when the
cursor is placed over the Button in Tooltip field. To make the linked file or icon stored

as part of the Board database, check the Store File and/or Store Icon checkboxes.

Button Setup )

QOrder Number l1— Button Level ISequT
Enabled v Parent ID |3

Caption [W Button 1D |1—
Command Line ]C:\WINDDWS system32\mspaint.exe Browse... |

File Path ]2: ‘\HuntronB oards\board-imagestboard-imag Browse... |
Icon File Path ] Browse... |

— Tooltip
Displays image of PCB top side

—Store File in Database —— ] [ Store lcon in Database

[~ Store File [Lead File.. | [~ Store lcon [Load File.. |

Ereviousl ewt I Add Newl OK | Cancel I Help |

Click OK to accept the Button. To create additional Buttons, repeat this process and
click the Add New button in the Button Setup window.

When Buttons are created, an additional toolbar will appear below the Huntron
Workstation menu. This toolbar will change according to the level (board, sequence or

component/net) selected.
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ndow Help

++ ‘.*l»o H g&&P:IlPI)N E

The icon shown can be replaced by selecting an appropriate icon in the Button Setup

window (the default icon is shown). Click the toolbar button to execute the Button.

Technical Support

For questions or assistance in using Huntron Workstation, contact Huntron at
800-426-9265, 425-743-3171 or email info@huntron.com.

There is online assistance for Huntron Workstation at

www.huntron.com/support/workstation.htm. This page will contains software updates,

a form for reporting software issues and updates to documentation such as this
tutorial.
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Appendix 1: Huntron Workstation Archive Scans Feature

The new Archive feature built into Huntron Workstation allows you store and remove
Sequence scans from the working database to achieve better performance. These
archived scans are not deleted but saved away in a different database table and can

be restored at any time. It is very simple to use.

Q Huntron Workstation (Developer) 4.3.6359.14616 C:\Users\Tester\Documents\Huntr
File | Edit | View Actions Tools Window Help

' u Add New Component Ctri+N
Edit Component Ctrl+E
Sﬂﬂ Delete Component Ctrl+D
Insert Component Ctrl+1

Repeat Component Ctrl+R

Build Component Ctrl+B

Copy Component

Paste Component

Cut Component Ctrl+X
Select All Component Ctrl+A

Delete Component Scans
Edit Board

Delete Board Non-Reference Scans

Archive Board Non-Reference Scans
UnArchive / Delete Board Non-Reference Scans

- Select "Archive Board Non-Reference Scans" from the Workstation Edit menu

- At this point the software will search the database for non-reference scans that were
part of a Sequence scan and remove them from the active database

- If you look at the Components Scans tab in the Tree pane, you will see that the
Reference scans remain

- To unarchive a scan, select "UnArchive / Delete Board Non-Reference Scans"

- The Sequence Scan Archive window will be displayed
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- You will see the Archive Scans listed where you can select the scan you want to
restore to your test Sequence. Use the CRTL or Shift keys to select multiple scans if
needed

- Click the UnArchive button and the selected scans will be restored to the Sequence

- Use the Delete button to permanently delete scans that are no longer needed.

- Close the Sequence Scan Archive window and look at your Component Scans tab and
you will see that your scans have been restored.

Keeping your test database small is the best way to get the most out Huntron

Workstation performance.

Cal Power

Via Acquanera, 29 22100 COMO
tel. 031.526.566 (ra.) fax 031.507.984
info@calpower.it www.calpower.it
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